


Part 1: The changing shapes of the SARS-CoV-2 spike protein
The SARS-CoV-2 spike protein has a special domain that changes shape (conformation). In the closed conformation, this domain is hidden from the immune system. In the open conformation, this domain can stick out and bind to a receptor on the surface of a cell. This domain is known as the receptor binding domain (RBD) because of its ability to bind to the receptor for SARS-CoV-2.   
Comparing structures of the spike protein in the open and closed conformations shows how one conformation helps the receptor binding domain hide from the immune system and the other conformation allows the receptor binding domain to contact a receptor and start infecting a cell. 

Identify a shape change in the SARS-CoV-2 spike protein and then locate the Receptor Binding Domain
Find the SARS-CoV-2 spike protein structure in the closed conformation and open it in iCn3D.
1. Go to the National Center for Biotechnology Information (NCBI) (https://ncbi.nlm.nih.gov).
a. In the search bar at the top, type “6VXX”. 
i. 6VXX is a PDB structure containing both the SARS-CoV-2 Spike protein in the closed confirmation.
b. In the box labeled “3-D structure,” click the “View in iCn3D” link.
2. In iCn3D, left-click the structure with your mouse and drag to turn the structure around and look at the three protein chains. Each chain is shown in a different color. These are subunits of the spike protein. In your current view, the spike protein complex is found in a “closed” conformation. 
[image: ]
Align the “closed” structure to a spike protein structure complex with the “open” conformation. Note- the reason the difference in structure is important is because the spike protein binds the ACE-2 receptor in the open conformation in order to enter our cells.
3. Click the File button and choose Align > Protein Complexes > 2 PDB structures.
a. Enter PDB IDs 6VXX (closed confirmation) and 6VSB (open confirmation) in the fields for ID1 and ID2, respectively, and click All Matching Molecules Superposed next to the VAST+ based on VAST. 
i. VAST is used when the sequences are highly similar. TM-aligned is used when sequences are more different. Since these are both coming from the same protein sequence, that only change in conformation, pick VAST.[image: ]
4. When the structures appear, the parts of the protein chains that are similar enough to be aligned will be shown in red. The unaligned regions will be shown in grey and blue. Look for regions of the proteins that are aligned and regions that are not aligned.[image: Picture]
5. Compare the two structures and identify the receptor binding domain (RBD).
a. Turn the structures so that the largest unaligned grey region appears at the top.
b. Press the “A” key on your keyboard or click the button that says “Alternate” to alternate between structures 6VXX and 6VSB.  You’ll have to press it more than once. 
You should see the shape of the unaligned grey region change, from pointing downward into the center of the spike molecule, to pointing upward. You can turn the structure around to see it better. That grey region is part of the Receptor Binding Domain (RBD). 

6. Alternate between the structures until you have the receptor binding domain pointing up. 

Practice changing the colors and shapes of the molecules in the structure.
7. Open the Style menu. Change the background color by choosing Background, White.
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a. Save an iCn3D PNG image for each of the two structures. You should have one image that shows the spike protein in a closed position and one that shows the spike protein in an open position.[image: Picture]
b. Paste the image files (png) in a document to hand in.  
c. In your Word (or other document program), circle the receptor binding domain in an image showing the open conformation. The spike protein only binds to its receptor in the open conformation.

[bookmark: _dy2rrp633dm3]Part 2 Instructions: Finding and aligning structures
This procedure shows a method for 1) aligning the spike proteins from two structures and 2) using the alignment to show where an antibody binds to the spike protein relative to the site where ACE2 binds to the spike protein. Aligning structures is helpful because it puts the structures in the same position making them easier to compare. You will also learn how to add annotations and how to save a link to your annotated structures so you can use them again.

Part A. Access the Sars-CoV-2 Spike protein Receptor Binding Domain (RBD) bound with ACE2
1. Go to the NCBI. 
2. In the top search bar, type “6M0J” (Note:  this PDB ID contains a zero, not the letter O) and hit “enter”.
3. In the box labeled “3-D structure,“ click the title of the structure. In this case, the title is “Crystal Structure of SARS-CoV-2 spike receptor-binding domain bound with ACE2.”
This structure contains a small portion of the SARS-CoV-2 spike protein and the ACE2 protein. Different letters and colors are used to identify the protein chains in this structure. 

4. Use the information in the table to determine which protein chain (A or E) corresponds to the Receptor Binding Domain (RBD) from the spike protein and which protein chain corresponds to the human ACE2 protein. Record your answers in the data sheet.
[image: Picture]
5. Scroll up to see the top of the page. On the right side of the page, click the Vast+ button.
[image: Picture]



Part B. Find neutralizing antibodies
6. Find the “search within results” area partway down the page. Type “neutralizing” in the “Search within results” area and click Go. This will allow you to search through the VAST+ results for aligned structures that contain neutralizing antibodies. 
[image: Picture]
We are searching for neutralizing antibodies because those are the antibodies that are most likely to be protective, at least against some variants of SARS-CoV-2.

7. Look through the table and find the row with PDB ID “6XE1” (below). We will use 6XE1 for this example. Toward the end of part 2, you will look at an alignment to a structure that contains a different neutralizing antibody. [image: Picture]

8. Click the + button on the left side of the PDB ID to view a diagram showing the protein chain from 6M0J aligned to a protein chain from the structure in the table (in this case the protein chain is the spike protein from 6XE1).  
9. A diagram of the protein chains in the structure will open below the row. 

This diagram shows that 6M0J contains the spike protein and ACE2. Also, you can see that 6XE1 contains the spike protein and the Fab portion of the CV30 antibody. The blue highlighting shows the aligned protein chains. In this case, the aligned chains are from the spike protein. 
[image: Picture]


Part C. Use iCn3D to visualize the Spike+ACE2 and Spike+Antibody complexes and practice annotating the structure to develop familiarity with these tools. 
Annotating is the process of adding extra information to a document or image. Sometimes images are annotated with labels. In the case of molecular structure models, annotations can include colors and drawing styles.

10. Click Visualize 3D structure superposition to view the aligned structures in iCn3D.
11. Annotate the structure to make it easier to identify and see where the ACE2 protein and antibody proteins are binding to the spike protein.  [image: Picture]
a. Open the Analysis menu and choose Seq. & Annotations.





b. Click the name of the ACE2 protein chain (6M0J_A). This action selects the chain and highlights it in yellow.
[image: Picture]
c. Open the Style menu. Choose Proteins, and then choose Sphere. Selecting a protein chain and choosing the Sphere drawing style will cause atoms in the selected protein (ACE2) to be drawn as spheres.  [image: Picture]










d. Open the Color menu. Choose “Unicolor” then choose white or another light color such as yellow. This selection will change the color of any selected protein chain (ACE2) to that color.[image: Picture]

12. Annotate the heavy and light chains of the antibody. 
a. Select the heavy chain of the antibody (CV30 Fab heavy chain) and use the same process as above to change the drawing style to spheres and the color to brown.
b. Select the light chain (kappa) (CV30 Fab Kappa chain). Change the drawing style to spheres and the color to blue.
[image: Picture]
13. Compare the structure of the spike protein bound to ACE2 with the structure of the spike protein bound to an antibody by pressing the “A” key on your keyboard or click the Alternate button to alternate between the structure containing ACE2 and the structure that contains an antibody.
If ACE2 and the antibody bind to the same part of the spike protein, then the antibody is likely to block binding to ACE2 and prevent infection.
Does this antibody look like it would interfere with the ability of the spike protein to bind to ACE2?
[image: Graphical user interface, application
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Part D. Repeat these steps with a different antibody to determine whether or not your new protein of interest is likely neutralizing or not.
14. Return to the VAST+ table at the NCBI (step 6).
15. Choose a different structure from the VAST+ table. This structure will contain a different neutralizing antibody.
16. Record the PDB ID for your new structure alignment.
17. Annotate ACE2, and the antibody in your new alignment, as you did in step 11 to determine if the antibody in your new structure might neutralize SARS-CoV-2 by blocking binding to ACE2. 
18. Alternate between the structures and save one image showing the spike protein bound to ACE2 and one image showing the spike protein bound to your new antibody.
19. Paste the images of your spike protein and ACE2 and your new antibody and the spike protein in your data sheet.
20. Open the File menu and choose Share link.
21. Copy the Lifelong Short URL and save it in your notes. 
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[bookmark: _or788ekxrtwz]Part 3: Identifying amino acids on the Spike protein used to bind ACE2 versus those used to bind an antibody
In this procedure, you will learn how the distance between the individual amino acid residues of an antibody and Spike protein can be used to determine if molecules are close enough to interact. You will also determine if two molecules (ACE2 and an antibody) bind to the same amino acids in the SARS-CoV-2 Spike protein. 
1. Use the Lifelong Short URL that you saved from Part 2 to open your aligned and annotated structures in iCn3D.
2. Alternatively, follow the instructions in Part 2 to align 6M0J with an antibody-containing structure other than 6XE1.  

Part A. Identify the amino acids of the Spike protein that bind to ACE2.  
1. Using 6M0J, open the Select menu and choose By Distance.[image: Graphical user interface, text, application

Description automatically generated]
2. For the first set, choose the ACE2 protein chain (6M0J_A).
3. Leave the radius at 4 angstroms.
4. For the second set, choose the Spike protein chain within the same structure (6M0J_E).
5. Click Display.
6. Close the current menu by clicking the “X” in the top right corner.
7. Open the Select menu and choose “Save Selection.”
8. Change the name to “ACE2_binding_site.”





Part B. Identify the amino acids of the Spike protein that bind to the antibody. 
1. Open the Select menu and choose By Distance.[image: Picture]
2. For the first set, you will select both the heavy and light chains of the antibody
a. First, click the antibody heavy chain (6XE1_H). 
b. Then, hold the control (PC) or command (mac) and click the antibody light chain (6XE1_L). Both chains should be selected.
3. Leave the radius at 4 angstroms.
4. For the second set, choose the Spike protein from the same structure (6XE1_E).
5. Click Display.
6. Close the current menu by clicking the “X” in the top right corner.
7. Open the Select menu again and choose “Save Selection.”
8. Change the name to “Antibody_binding_site.”

Part C. Compare the two Spike protein sequences to see if the antibody binds to the same amino acids that the Spike protein uses to bind to ACE2.[image: Picture]
1. Open the Analysis menu and choose Aligned Seq. A new window will open with the aligned spike protein sequences from 6M0J_E and 6XE1_E.  
2. Open the Analysis menu again and choose Defined Sets.
3. Select the ACE2_binding_site and hold the Shift key down while you select the Antibody_binding_site. Amino acids that make up the binding site between the Spike protein and either ACE2 or the antibody will now be highlighted in the sequence alignment to the right. [image: Picture]

Look carefully at the sequence alignment to see which sequence is on top and which is on the bottom. The 6M0J spike protein sequence is on top in the image below. Note that 6M0J_E and 6XE1_E contain the same sequence of the Spike protein but are named differently because they are identified as bound with ACE2 (6M0J_E) or the antibody (6XE1_E). As you scroll through the sequence, you will see highlighted amino acids. The spike protein in 6M0J is bound to ACE2, so these highlighted amino acids make up the ACE2 binding site. The spike protein sequence from the antibody-containing structure, in this case 6XE1, is on the bottom. Highlighted amino acids in this sequence constitute the antibody binding site. 

Your goal now is to determine if the ACE2 protein contacts the same amino acids as the antibodies.[image: Picture]


4. Scroll to view the rest of the protein sequence. 
[image: Picture]
[image: Picture]
[image: Picture]
Amino acids in the spike protein that contact the ACE2 protein (top) or the antibody (bottom) are highlighted yellow. If the antibody binds to the same amino acids as the spike protein, it can prevent the virus from binding to the ACE2 receptor and infecting a cell.

5.  Capture images from your aligned sequences to show the amino acids in the antibody binding site from your structure. Include one image that shows the chain names for the aligned sequences.


[bookmark: _wud2dsssdf90]Part 4: Find emerging Sars-CoV-2 variants using NextStrain.org & identify mutations
NextStrain.org is an open-source research project that provides continually updated views of pathogen evolution and spread. A worldwide consortium of scientists and programmers collaborate on the NextStrain platform to create interactive visualizations for exploring changes in genome sequences over time.
This project provides a short introduction to NextStrain.org and instructions for obtaining a protein sequence from a viral sample.
1. Go to NextStrain.org.
You may want to scroll down and read about the philosophy of this website and why the scientists that developed NextStrain believe in the importance of monitoring changes in pathogen genomes.

2. Scroll down to find the “SARS-CoV-2 (COVID-19)” heading and click “Latest global analysis - open data.”
Many if not all the samples are linked to sequence data in the NCBI.

Part A. A quick tour of NextStrain.org
1. Phylogeny  
You will see an interactive phylogenetic tree that represents the real time evolution of SARS-CoV-2. This tree is derived from genome sequences contributed by scientists from all over the world.  

Each branch of the tree represents a new mutation. Time is shown on the X axis. The tree is divided into groups of related sequences called “clades.” Clades are groups of sequences that share a common origin. When a group of viruses reaches a global frequency of at least 20%, they are designated a major clade. Major clades are named based on the next available letter in the Greek alphabet and the year they emerged. The upper left key panel shows the names of major clades and their corresponding colors.[image: Timeline
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If you hold your cursor over a branch of the tree, you will see the mutations that are found in that branch. Each circle represents a sample of virus that was collected from an individual and sequenced.  If you hold your cursor over a circle, you will see more details about that sample. Note the differences you see today versus the screenshot to the right from 2022.

2. World map  
Scroll down to see a map of the world with pie charts representing the frequency of each clade. Genome sequencing is more common in some countries than others, so the size of the pie varies by country. Note the differences you see today versus the screenshot below from 2022.
[image: Diagram
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3. Mutation frequency 
Scroll down further and you’ll see a map of the SARS-CoV-2 genome from the 5' end on the left to the 3' end on the right. The values on the y axis show the frequency of mutations at each position.

The gene that codes for the spike protein (S) shows the highest frequency of mutations in 2022. What are you seeing when you look at the chart today? Some of these mutations make the virus more transmissible. Other changes help the virus escape the immune system. 

[image: Timeline

Description automatically generated with medium confidence]



4. Frequencies
Scroll down again to see the proportion of each clade at any given time. If we click one of the vertical lines in the mutation frequency plot, the frequency plot below will change to show the proportion of samples with each sequence. Note the differences you see today versus the screenshot below from 2022.

[image: A picture containing chart
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Part B. Obtaining a protein sequence from NextStrain.org and the NCBI
1. Go to NextStrain.org
2. Find SARS-CoV-2 (COVID-19) and click “Latest global analysis - open data.”
3. Find the phylogenetic tree.  
4. Pick a sample to investigate by clicking one of the circles in the tree.
You can either select a sample from an older clade or a sample from an emerging lineage. In either case, the protein sequence will help us determine if a viral strain might be able to escape commercial antibodies or the immunity generated by current vaccines. 



If you would like to investigate an emerging lineage, open the “Color By” menu and choose Emerging Lineage. Emerging lineages will appear in color and other clades will appear grey. 

A report will appear with information from that sample such as the location where the sample was obtained and the date. You will also see the name of the clade, the emerging lineage (if relevant), and all the mutations that have taken place since the first viral genome was obtained from the Wuhan fish market in 2020. 














Confirm that the sample “Host” is “Homo sapiens.”

5. Click the Genbank accession number to open the nucleotide sequence record at the NCBI.
6. Look under the title and Genbank accession number to find a link to Graphics. 
a. Click the Graphics link to view a map of the viral genome.[image: Picture]






















The graphic genome map uses green rectangles to represent genes, red rectangles for proteins, and brown rectangles for processed proteins.
[image: Picture]

7. The arrow in the image above points to the accession number for the spike protein sequence. 
a. Find the spike protein in your genome map. 
b. Hold your cursor over the accession number for your spike protein. [image: Picture]
c. A grey box will appear below the spike protein. 
d. Drag your cursor over the accession number (CDS) and copy it from this box. CDS stands for Coding Sequence. In this case, the CDS is UKA19918.1. Your CDS will be a different number and letter combination. 
8. Check the quality of your protein sequence. 
a. Paste the accession number in the search bar at the top of the page. 
b. Click Search.
[image: ]
9. Look at the amino acid sequence.  
If the sequence shows lots of X’s, find another sequence to investigate. X’s are used as placeholders when part of the sequence can’t be identified. If there are none (or very few) X’s, you are ready to move on to Part 5.


[bookmark: _i74395hs3q94]Part 5: Predict the effect of spike mutations on antibody binding
During the pandemic, several companies developed commercial products from monoclonal antibodies against the SARS-CoV-2 spike protein. Emergency Use Authorizations (EUA) from the FDA allowed these antibodies to be used for treating COVID-19. An important question about these antibodies is whether they remain effective against new SARS-CoV-2 variants.
Bamlanivimab is one example. Bamlanivimab is a monoclonal antibody developed by AbCellera Biologics and Eli Lilly as a treatment for COVID-19. The US Food and Drug Administration granted Bamlanvimab an EUA in November 2020. In April 2021, the EUA was revoked because the antibody was not effective against several SARS-CoV-2 variants. 
Looking at Bamlanivimab can show us how mutations can change the ability of an antibody to bind to a protein and help us learn how to predict the effectiveness of other commercial antibodies.
1. Follow the instructions in this example to see how mutations are likely to affect the ability of Bamlanavimab to bind to the spike protein.
2. Repeat these steps with the different variant of SARS-CoV-2 you found in Part 4 to see how the mutations in your variant impact may affect binding by the Bamlanivimab antibody.

Part A. Find the Bamlanivimab + Sars-Cov-2 Spike protein structure in the NCBI structure database
1. Go to the NCBI and search for 7KMG. 
2. Click the title “LY-CoV555 neutralizing antibody against SARS-CoV-2” to open the NCBI structure record for 7KMG.  
A challenge in working with molecular structures is that an antibody will have a different name when it’s sold as a drug than it has in molecular structure models. This discrepancy occurs because researchers may use their own, or their company’s naming system, when they are researching antibodies. When a company decides to develop an antibody for use as a therapeutic agent, they are required to give it a name based on a standardized system. 

7KMG contains the antibody LY-CoV555 bound to the receptor binding domain (RBD) of the SARS-CoV-2 spike protein. When LY-CoV555 is sold as a drug, the name used is Bamlanivimab.
   
3. Scroll down on the page to find the table titled “Molecular Components in 7KMG” to identify and record the chain names for the antibody light and heavy chains and the spike protein.  You will need these later.
A chain name consists of the PDB ID, an underscore, and a letter. For example, the chain name for the spike protein is 7KMG_C.

7KMG only contains a small part of the spike protein but the portion it contains is important for infecting a host cell and an important target for antibodies.
4. Just above the table is a “Molecular Graphic” of 7KMG. In the black box, click the “full-featured 3D viewer button” to open the structure in iCn3D.  
5. Look in the Sequences and Annotations window to confirm the protein chains correspond to the antibody heavy and light chains and the spike protein you identified in step 3. Make a note to remember later if the protein chains do not match.
If the Sequences and Annotations window is not visible, click “Analysis” and then click “Seq. & Annotations.”
[image: Picture]
Part B. Align the spike protein sequence from a SARS-CoV-2 variant from Part 4 with the spike protein sequence in the molecular structure of 7KMG
1. Open the File menu, choose Align, then Sequence to Structure.
2. In the Sequence ID window, delete the existing accession number and replace it with the Genbank accession number for the variant spike protein sequence that you found from using NextStrain.org (Part 4). The example will be illustrated using the sample sequence (from the previous assignment): UKA19918.1 
[image: Picture]
3. Replace the default chain name (1TSR_A) with the chain name for the spike protein in your structure. In our example, we will use 7KMG_C.
4. Click the Align with BLAST button. 
BLAST will determine where the amino acid sequence from your NextStrain variant (Part 4) matches the sequence of 7KMG_C and present the aligned sequences.

Information about the alignment will appear in both the structure and the sequence alignment. If amino acids are the same or similar, they will be colored red or pink in both the sequence and the structure. Amino acids that differ will be colored blue.


Part C. Add annotations to the antibody[image: Picture]
1. In the new alignment page you just created, create an “antibody” set.
a. Click “Select” and then choose “Defined Sets.”
b. Hold the shift key down and click the chain names that correspond to the light and heavy chains of the antibody. 
c. Click “Select” and then choose “Save Selection.”  
d. Change the name of your selection to “antibody” and click Save.
2. Create an antibody+spike protein complex as a defined set.
a. Click “Select” and choose “Defined Sets.”[image: Picture]
b. Hold the command key down and click the chain names for the spike protein and the antibody. 
c. Click “Select” again and choose “Save Selection.”  
d. Change the name of your selection to “antibody+spike” and click Save.
3. Open the View menu and choose View Selection. 
The antibody and the spike protein RBD will appear in the structure window.







Part D. Annotate the antibody binding site[image: Picture]
1. In the same page, click “Select” and then choose “by Distance.” 
2. Choose antibody in the first set and the chain name for the spike protein in the second. 
3. Click Display. 
4. Close the box by clicking the X in the top right corner.
Amino acids that contact the antibody will be highlighted yellow.
5. Open the Select menu and choose Save Selection. 
Name the selection “antibody binding site.”


Part E. Identify mutations in the variant spike protein that are located in the antibody binding site.
1. Look in the Sequences and Annotations window to find the aligned spike protein sequences.[image: Picture]

The top sequence, 7KMG_C, is the amino acid sequence of the spike protein from 7KMG. The Query sequence shows the accession number from the sample we found at NextStrain.org (Part 4). If an amino acid from the query matches the corresponding amino acid in the 7KMG_C sequence in the BLAST search, its one letter code is colored red or pink. If the two amino acids are different, then the letter in the spike protein sequence is shown in blue.  

If you hold your cursor over an amino acid, the one letter amino acid code and its position will appear.  

In the image above, the 7KMG spike protein has a glycine at position 339, while the variant sequence has an aspartic acid (D). G339 is colored blue to show that these amino acids are different.

Amino acids in the antibody binding site, like tyrosine (Y) 351 are identified by a yellow highlight.

2. Scroll through to the end of the aligned sequences to identify any differences between the amino acids in the binding site. This example has amino acid differences at E484 and Q493.
[image: Picture]



Part F.  Look at the predicted effect of mutations on antibody binding
We can predict how amino acid changes in the antibody binding site might affect antibody binding by examining the interactions between the 7KMG_C amino acids and the antibody and comparing those interactions to the predicted interactions between the variant amino acid and the antibody.[image: Picture]
1. Open the Analysis menu and choose Mutation.
2. Replace the information in the top field with the chain name, position, and variant for your sample. For our example, this is 7KMG_C_484_A. Be sure to type carefully.
[image: Picture]
3. Click the Interactions button.

A new window with two portions will appear. The left side will show a 3D structure and the right side will show information about the interactions between the amino acid and other objects in the structure. [image: Picture]

4. In the structure window on the left, you will see an alignment between the structure with the original amino acid and the structure with the mutation. Use either the “A” key on your keyboard or the Alternate button to toggle between the amino acid in 7KMG_C and the mutant amino acid. 




In our example, the pink protein chain is the heavy chain from antibody LY-CoV555 and the blue chain is the light chain. The spike protein is colored brown. Dashed lines between an amino acid and the protein chains show all the bonds that an amino acid is likely to form. The color of the line indicates the type of bond as described in the key below.

[image: Picture]
When you toggle or switch between the structures, you may see a change in the numbers and kinds of bonds between the amino acid and the protein chains.   

The number and kinds of bonds between an antibody and another substance is important because these bonds determine the strength of that interaction. An antibody that can form multiple bonds to a protein will bind more tightly than one that cannot.

5. In the interactions window on the right, you will see diagrams that respresent the interactions between the amino acid being examined and objects in the structure.  [image: Picture]

The image to the right shows bonds between the glutamic acid (E) at position 484 in the original spike protein and either amino acids or oxygens.  R50, Y101, and Y110 (pink circles) represent an arginine and two tyrosines in the heavy chain. R96 (blue circle) is an arginine in the light chain.  I472, V483, G484, and C488 are an isoleucine, valine, glycine, and cysteine in the spike protein (brown circles). O97 and O99 are oxygens (red circles).[image: Picture]

We can also identify the kinds of bonds that are formed. The blue lines show that E484 forms salt bridges (ionic interactions) with R50 in the heavy chain and R96 in the light chain. The grey lines are hydrophobic interactions, and the green lines are hydrogen bonds.

The mutation we are studying replaces E484 with an alanine. This second diagram shows how the interactions are likely to change if the glutamic acid is replaced with an alanine. It is clear the alanine is likely to form fewer bonds to the heavy chain of the antibody. In fact, both the salt bridges are gone and A484 only forms a hydrophobic interaction with Y110 and a hydrogen bond with R96. This interaction is far weaker. 
iCn3D also highlights the interactions that differ between the two amino acids. If we scroll down, we can see that E484 has five interactions that are predicted to be lost when this amino acid is replaced by an alanine.  



This diagram makes it clear that the mutation from glutamic acid to alanine has a negative impact on binding. Most of the bonds are gone. This helps to explain why Bamlanavimab no longer protects against this variant and the EUA was withdrawn.
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